Chapter 466

Equivalence Tests for the Ratio of Two Within-Subject Variances in a Parallel Design

Introduction

This procedure calculates power and sample size of equivalence tests of within-subject variabilities from a two-group, parallel design with replicates.

Technical Details

This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018).

Suppose $x_{ijk}$ is the response of the $i$th treatment ($i = 1, 2$), $j$th subject ($j = 1, \ldots, Ni$), and $k$th replicate ($k = 1, \ldots, M$). The model analyzed in this procedure is

$$x_{ijk} = \mu_i + S_{ij} + e_{ijk}$$

where $\mu_i$ is the treatment effect, $S_{ij}$ is the random effect of the $j$th subject in the $i$th treatment, and $e_{ijk}$ is the within-subject error term which is normally distributed with mean 0 and variance $V_i = \sigma_{W_i}^2$. Unbiased estimates of these variances are given by

$$\hat{V}_i = \frac{1}{N_i(M - 1)} \sum_{j=1}^{Ni} \sum_{k=1}^{M} (x_{ijk} - \bar{x}_{ij})^2$$

A common test statistic to compare variabilities in the two groups is $T = \hat{V}_1 / \hat{V}_2$. Under the usual normality assumptions, $T$ is distributed as an $F$ distribution with degrees of freedom $N_1(M - 1)$ and $N_2(M - 1)$. 
Testing Equivalence

The following hypotheses are usually used to test for equivalence

\[ H_0: \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} \leq RL \quad \text{or} \quad \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} \geq RU \quad \text{versus} \quad H_1: RL < \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} < RU, \]

where RL and RU are the equivalence limits.

These hypotheses can be tested using the two one-sided hypotheses

\[ H_{01}: \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} \geq RU \quad \text{versus} \quad H_{11}: \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} < RU \]

and

\[ H_{02}: \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} \leq RL \quad \text{versus} \quad H_{12}: \frac{\sigma^2_{W_1}}{\sigma^2_{W_2}} > RL \]

The corresponding test statistics are \( T_1 = RU \left( \frac{V_{1}}{V_{2}} \right) \) and \( T_2 = RL \left( \frac{V_{1}}{V_{2}} \right) \).

Power

The power of this combination of tests is given by

\[
\text{Power} = P \left( \frac{RL}{R} F_{1-\alpha, N_1(M-1), N_2(M-1)} < F < \frac{RU}{R} F_{\alpha, N_1(M-1), N_2(M-1)} \right)
\]

where \( F \) is the common F distribution with the indicated degrees of freedom, \( \alpha \) is the significance level, and \( RL \) is the value of the variance ratio stated by the alternative hypothesis. Lower quantiles of \( F \) are used in the equation.

A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary sample size.

Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

Solve For

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of nonequivalent means when in fact the means are equivalent.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of nonequivalent means when in fact the means are nonequivalent.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation
Select the option that describes the constraints on \( N_1 \) or \( N_2 \) or both.

The options are

- **Equal (\( N_1 = N_2 \))**
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- **Enter \( N_2 \), solve for \( N_1 \)**
  Select this option when you wish to fix \( N_2 \) at some value (or values), and then solve only for \( N_1 \). Please note that for some values of \( N_2 \), there may not be a value of \( N_1 \) that is large enough to obtain the desired power.

- **Enter \( R = N_2/N_1 \), solve for \( N_1 \) and \( N_2 \)**
  For this choice, you set a value for the ratio of \( N_2 \) to \( N_1 \), and then PASS determines the needed \( N_1 \) and \( N_2 \), with this ratio, to obtain the desired power. An equivalent representation of the ratio, \( R \), is
  \[
  N_2 = R \times N_1.
  \]

- **Enter percentage in Group 1, solve for \( N_1 \) and \( N_2 \)**
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed \( N_1 \) and \( N_2 \) with this percentage to obtain the desired power.

**\( N_2 \) (Sample Size, Group 2)**

*This option is displayed if Group Allocation = “Enter \( N_2 \), solve for \( N_1 \)”*

\( N_2 \) is the number of items or individuals sampled from the Group 2 population.

\( N_2 \) must be \( \geq 2 \). You can enter a single value or a series of values.
**R (Group Sample Size Ratio)**

This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N1 = 10 \) and \( N2 = 20 \), or \( N1 = 50 \) and \( N2 = 100 \)).

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single or a series of values.

**Percent in Group 1**

This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

---

**Sample Size (When Not Solving for Sample Size)**

**Group Allocation**

Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**

  This choice permits you to enter different values for N1 and N2.

- **Enter N1 and R, where N2 = R * N1**

  Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

- **Enter total sample size and percentage in Group 1**

  Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N, and then N2 as \( N - N1 \).

**Sample Size Per Group**

This option is displayed only if Group Allocation = “Equal (N1 = N2).”

The Sample Size Per Group is the number of items or individuals sampled from each of the Group 1 and Group 2 populations. Since the sample sizes are the same in each group, this value is the value for N1, and also the value for N2. The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Group 1)

This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2 = R * N1.”

N1 is the number of items or individuals sampled from the Group 1 population.

N1 must be ≥ 2. You can enter a single value or a series of values.

N2 (Sample Size, Group 2)

This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”

N2 is the number of items or individuals sampled from the Group 2 population.

N2 must be ≥ 2. You can enter a single value or a series of values.

R (Group Sample Size Ratio)

This option is displayed only if Group Allocation = “Enter N1 and R, where N2 = R * N1.”

R is the ratio of N2 to N1. That is,

\[ R = \frac{N2}{N1} \]

Use this value to obtain N2 as a multiple (or proportion) of N1.

N2 is calculated from N1 using the formula:

\[ N2 = \lceil R \times N1 \rceil, \]

where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting R = 2.0 results in a Group 2 sample size that is double the sample size in Group 1.

R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can enter a single value or a series of values.

Total Sample Size (N)

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines N1 and N2.

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 2.

You can enter a single value or a series of values.

Percent in Group 1

This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

M (Measurements Per Subject)

Enter one or more values for M: the number of repeated measurements made on each subject.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is M ≥ 2.
Effect Size

RU (Upper Equivalence Limit)
Enter one or more values for the upper equivalence limit for the ratio of the two within-subject variances. When the ratio of the sample variances is between this value and RL, the two groups are said to have "equivalent" variances.

This value must be greater than one. Popular choices are 1.5 and 2.

Note
If you enter "1/RL", then 1/RL will be calculated and used for RU. This choice is popular because RL and RU=1/RL results in limits that are of equal magnitude on the log scale.

RL (Lower Equivalence Limit)
Enter one or more values for the lower equivalence limit for the ratio of the two within-subject variances. When the ratio of the sample variances is between this value and RU, the two groups are said to have "equivalent" variances.

This value must be less than one. Popular choices are 0.5 and 0.67.

If you enter "1/RU", then 1/RU will be calculated and used for RL. This choice is popular because RU and RL=1/RU results in limits that are of equal magnitude on the log scale.

R1 (Actual Variance Ratio)
Enter one or more values for within-subject variance ratio assumed by the alternative hypothesis. This is the value of $\frac{\sigma_w^2}{\sigma_w^2}$ at which the power is calculated.

This value should be between the two equivalence limits. Hence, RL < R1 < RU.
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to show that it is equivalent to the standard drug with respect to the within-subject variance. A parallel-group design with replicates (repeated measures) will be used to test the equivalence of the two drugs.

Company researchers set the upper limit of equivalence to 1.5, the lower limit to 1/1.5, the significance level to 0.05, the power to 0.90, M to 2 or 3, and the actual variance ratio values between 0.8 and 1.3. They want to investigate the range of required sample size values assuming that the two group sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Equivalence Tests for the Ratio of Two Within-Subject Variances in a Parallel Design procedure. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Power</td>
<td>0.9</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>2 3</td>
</tr>
<tr>
<td>RU (Upper Equivalence Limit)</td>
<td>1.5</td>
</tr>
<tr>
<td>RL (Lower Equivalence Limit)</td>
<td>1/RU</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>0.8 0.9 1 1.1 1.2 1.3</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Group 1 Sample Size N1</th>
<th>Group 2 Sample Size N2</th>
<th>Measures Per Subject M</th>
<th>Lower Equiv Limit Variance Ratio RL</th>
<th>Upper Equiv Limit Variance Ratio RU</th>
<th>Actual Variance Ratio R1</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9002</td>
<td>1032</td>
<td>1032</td>
<td>2</td>
<td>0.667</td>
<td>1.500</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9002</td>
<td>516</td>
<td>516</td>
<td>3</td>
<td>0.667</td>
<td>1.500</td>
<td>0.800</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9001</td>
<td>382</td>
<td>382</td>
<td>2</td>
<td>0.667</td>
<td>1.500</td>
<td>0.900</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9001</td>
<td>191</td>
<td>191</td>
<td>3</td>
<td>0.667</td>
<td>1.500</td>
<td>0.900</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9009</td>
<td>265</td>
<td>265</td>
<td>2</td>
<td>0.667</td>
<td>1.500</td>
<td>1.000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9022</td>
<td>133</td>
<td>133</td>
<td>3</td>
<td>0.667</td>
<td>1.500</td>
<td>1.000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9004</td>
<td>359</td>
<td>359</td>
<td>2</td>
<td>0.667</td>
<td>1.500</td>
<td>1.100</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9012</td>
<td>180</td>
<td>180</td>
<td>3</td>
<td>0.667</td>
<td>1.500</td>
<td>1.100</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9001</td>
<td>689</td>
<td>689</td>
<td>2</td>
<td>0.667</td>
<td>1.500</td>
<td>1.200</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9004</td>
<td>345</td>
<td>345</td>
<td>3</td>
<td>0.667</td>
<td>1.500</td>
<td>1.200</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9000</td>
<td>1674</td>
<td>1674</td>
<td>2</td>
<td>0.667</td>
<td>1.500</td>
<td>1.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9000</td>
<td>837</td>
<td>837</td>
<td>3</td>
<td>0.667</td>
<td>1.500</td>
<td>1.300</td>
<td>0.050</td>
</tr>
</tbody>
</table>
Equivalence Tests for the Ratio of Two Within-Subject Variances in a Parallel Design

Report Definitions
Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly larger than the target power.

N1 is the number of subjects from group 1. Each subject is measured M times.
N2 is the number of subjects from group 2. Each subject is measured M times.
N is the total number of subjects. N = N1 + N2.
Target R is the desired ratio of N2 to N1, so that R = N2 / N1.
M is the number of times each subject is measured.
RL is the lower equivalence (similarity) limit for the within-subject variance ratio.
RU is the upper equivalence (similarity) limit for the within-subject variance ratio.
R1 is the value of the within-subject variance ratio at which the power is calculated.
Alpha is the probability of rejecting a true null hypothesis, H0.

Summary Statements
A study is being conducted to assess the equivalence of the within-subject variability of two groups by looking at the ratio of their variances. If the sample variance ratio falls between two equivalence limits, the groups are concluded to be 'equivalent'. Otherwise, they are not. Group sample sizes of 1032 and 1032 achieve 90% power to reject the null hypothesis of non-equivalence at a significance level of 0.050. The lower equivalence limit is 0.667. The upper equivalence limit is 1.500. The within-subject variance ratio at which the power is calculated is 0.800. Each subject is measured 2 times.

This report gives the sample sizes for the indicated scenarios.

Plot Section

These plots show the relationship between sample size, R1, and M.
Example 2 – Validation using Hand Calculations

We could not find an example in the literature, so we will present hand calculations to validate this procedure.

Set \( N_1 \) to 265, the upper limit of equivalence to 1.5, the lower limit to 1/1.5, the significance level to 0.05, \( M \) to 2, and the actual variance ratio values 1.0. Compute the power.

The calculations proceed as follows.

\[
\text{Power} = P \left( \frac{RU}{R1} F_{1-\alpha, N_1(M-1), N_2(M-1)} < F < \frac{RU}{R1} F_{\alpha, N_1(M-1), N_2(M-1)} \right) \\
= P \left( 0.666667/1 (F_{0.95,265,265}) < F < 1.5/1 (F_{0.05,265,265}) \right) \\
= P(0.666667(1.22439660) < F < 1.5(0.81672883)) \\
= 0.95047403 - 0.049525978 \\
= 0.90094805
\]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the *Equivalence Tests for the Ratio of Two Within-Subject Variances in a Parallel Design* procedure. You may then make the appropriate entries as listed below, or open *Example 2* by going to the *File* menu and choosing *Open Example Template*.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>265</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>2</td>
</tr>
<tr>
<td>RU (Upper Equivalence Limit)</td>
<td>1.5</td>
</tr>
<tr>
<td>RL (Lower Equivalence Limit)</td>
<td>1/RU</td>
</tr>
<tr>
<td>R1 (Actual Variance Ratio)</td>
<td>1.0</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
<th>Group 1</th>
<th>Group 2</th>
<th>Measures Per Subject</th>
<th>Lower Equiv Limit Variance Ratio</th>
<th>Upper Equiv Limit Variance Ratio</th>
<th>Actual Variance Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>0.9009</td>
<td>0.667</td>
<td>1.500</td>
<td>1.000</td>
<td>0.050</td>
<td></td>
</tr>
</tbody>
</table>

The power matches and our hand calculations.